**TABLE OF CONTENTS**  
Superalloy 718 and Derivatives

Preface ...................................................................................................................................................................................... xi  
Conference Proceedings Editorial Board .................................................................................................................................... xiii  
Conference Organizing Committee ..................................................................................................................................... xiv  

8th International Symposium on Superalloy 718 and Derivatives

**Keynote Session**

Lessons Learned from the Development, Application and Advancement of Alloy 718 ................................................... 3  
*F. Preli and D. Furrer*

100+ Years of Wrought Alloy Development at Haynes International .............................................................................. 15  
*L. Pike*

**Trends in 718 and Derivatives**

Recent Progress of Manufacturing Technologies on C&W Superalloys in China .......................................................... 33  
*J. Du, Q. Deng, J. Dong, X. Xie, Z. Wang, C. Zhao, G. Chen, W. Xie, T. Luo, X. Wang, and Y. Zhang*

Features of Slag-Metal Interaction at Electroslag Remelting of Superalloys .................................................................. 47  
*S. Ganna, G. Iaroslav, and M. Lev*

Multiscale Modeling of the Solidification Structure Evolution of VAR-Processed Alloy 718 Ingots .............................. 57  
*L. Nastac*

Development of a New Cast and Wrought Alloy (René 65) for High Temperature Disk Applications .......................... 67  
*J. Heaney, M. Lasonde, A. Powell, B. Bond, and C. O’Brien*

**Wrought Processing, Development, and Modeling**

Computational Modeling and Simulation of Alloy 718 ...................................................................................................... 81  

Recrystallization Response during Thermo-Mechanical Processing of Alloy René 65 Billet ........................................... 95  
*R. Minisandram, L. Jackman, J. Russell, M. Lasonde, J. Heaney, and A. Powell*

René 65 Billet Material for Forged Turbine Components .................................................................................................. 107  
*B. Bond, C. O’Brien, J. Russell, J. Heaney, and M. Lasonde*

Reverse vs. Effective Strain in the Ring-Rolling of Superalloy 718 ............................................................................... 119  
*J. Alkorta, J. Martinez-Esnaola, I. Gutierrez, D. Rawson, M. Verza, S. Reghellin, and J. Gil Sevillano*

Research on Large-Scale Turbine Disk of Wrought GH4738 Superalloy Using Microstructure Evolution  
Precision Control Models Combined with Integrated Simulation Methods ................................................................. 129  
*Z. Yao, L. Li, M. Zhang, J. Dong, and X. Xie*
Superplastic Properties of Ultrafine-Grained Allvac 718Plus Alloy Processed by Multiple Forging
S. Mukhtarov and V. Imayev

Finite Element Analysis Using a Dislocation Density Based Flow Stress Model Coupled with Model for Precipitate Evolution
M. Fisk, A. Lundback, J. Andersson, and L. Lindgren

Cast Processing, Development, and Modeling

The Golden Age of Cast Structural Superalloys
R. Helmink

Solidification of Alloy 718, ATI 718Plus and Waspaloy
J. Andersson, S. Raza, A. Eliasson, and K. Surreddi

Effects of Refiners on Grain Structures of Superalloy IN 718 at High Pouring Temperature
Z. Jie, J. Zhang, T. Huang, Z. Zhao, L. Liu, and H. Fu

Properties of Investment Cast RS5 Heat Treated in an Optimised Four Step Route
W. Li and P. Andrews

Selection of Heat Treatment of ATI 718Plus Casting
O. Caballero Ruiz and N. Soldevilla

Relationship Between the Tensile Properties, Microstructures, and the Macrostructure of the Investment Complex-Shaped Casting
J. Wang, H. Gao, and M. Kang

Grain Structure and Segregation Modeling Using Coupled FV and DP Model
S. Mosbah

Joining and Fabrication Processing

Weldability of Ni-based Superalloys
J. Andersson

Influence of Deformed Surface Layer When Machining Wrought Alloy 718 in an Annealed and in a Pre-Strained Condition
S. Cedergren, J. Johansson, and G. Sjöberg

Weldability and Welding Metallurgy of Haynes 282 Alloy
J. Caron

Effect of Repeated Solution Cycles on Cast INCO 718
ITP, B. Barasoain, and O. Caballero
Heat Treatment and Thermal Processing

Comparison of Microstructural Changes in Three Different Ni-base Superalloys after Cyclic Thermo-Mechanical Treatment ................................................................. 303  
D. Huber, M. Hacksteiner, C. Poletti, F. Warchomicka, and M. Stockinger

Impact of Thermomechanical Aging on Alloy 625 High Temperature Mechanical Properties .............................................................. 317  
L. Mataveli Suave, D. Bertheau, J. Cormier, P. Villechaise, A. Soula, Z. Hervier, F. Hamon, and J. Laigo

Impact of the Solution Cooling Rate and of Thermal Aging on the Creep Properties of the New Cast & Wrought René 65 Ni-Based Superalloy ......................................................... 333  
A. Laurence, J. Cormier, P. Villechaise, T. Billot, J. Franchet, F. Petinari-Sturmel, M. Hantcherli, F. Mompiou, and A. Wessman

Tensile and Creep Strength of Thermally Exposed Allvac 718Plus .................................................................................................................. 349  
M. Pröbstle, S. Neurmeier, D. Hünert, and M. Göken

Stability of Gamma Prime in H282: Theoretical and Experimental Consideration ........................................................................................................ 361  
Y. Wen, T. Cheng, P. Jablonski, J. Sears, and J. Hawk

The Effect of Prior TMP on Annealed Grain Size in HAYNES 282 Alloy .......................................................................................... 379  
D. Metzler and M. Fahrmann

Novel Processing Methods

Review of Laser Deposited Superalloys Using Powder as an Additive ...................................................................................... 393  
A. Segerstark, J. Andersson, and L. Svensson

Effect of Process Control and Powder Quality on Inconel 718 Produced Using Electron Beam Melting ..................................................... 409  
W. Sames, F. Medina, W. Peter, S. Babu, and R. Dehoff

HIP-Densification of Alloy 718 and ATI 718Plus ............................................................................................................. 425  
J. Andersson, F. Vikström, and B. Pettersson

Metal Injection Molding of Alloy 718 for Aerospace Applications ................................................................................................. 437  
T. Yoshinouchi, N. Tsuno, S. Ikeda, and H. Yoshizawa

Development of Prior Particle Boundary Free Hot-Isostatic-Pressing Process for Inconel 718 Powder ...................................................... 447  
L. Chang, W. Sun, Y. Cui, and R. Yang

Microstructural Analysis on 3D Printed Nickel-based Alloy 718 ............................................................................................................. 459  
N. Aung, T. Chen, J. Morton, and X. Liu

Modified T-T-T Behavior of IN625® Cold Sprayed Coatings ............................................................................................................. 469  
D. Srinivasan and R. Amuthan

Rotary Bending Fatigue and Seizure Characteristics of Inconel 718 Alloy After Ultrasonic Nanocrystal Surface Modification (UNSM) Treatment .................................................................................. 483  
H. Kim, R. Kayumov, A. Amanov, J. Kim, Y. Pyun, Q. Wang, and K. Muhammad

Product Application and Technology

Status of Precipitation Hardened Nickel Base Alloys Including 718 for Oilfield Applications ................................................................. 493  
R. Badrak
Development of ATI 718Plus for High Temperature High Strength Fastener Applications ................................................503
W. Li, D. Terret, E. McDevitt, S. Ndoye, and S. Gardner

Effect of Aging Heat-Treatment on Mechanical Properties of AD730 Superalloy ..........................................................521
A. Devaux, A. Helstroffer, J. Cormier, P. Villechaise, J. Douin, M. Hantcherli, and F. Pettinari-Sturmel

Hold Time Effects on the Crack Growth Behavior in Inco 718 Alloy ........................................................................537
S. Pierret, R. De Moura Pinho, and A. Pineau

Advancements in Mechanical Properties and Microstructures

Fine Grain Structure as Palliatives for Fretting Wear of Inconel 718 Alloy at Various Temperatures ........................................555
A. Amanov, Y. Pyun, W. Qingyuan, and M. Kashif Khan

The Effect of Composition on the Gamma Prime Distribution of Ni-Cr-Al-Nb Alloys ..................................................563
P. Mignanelli, N. Jones, M. Hardy, and H. Stone

Morphology and Kinetics of Grain Boundary Precipitation in Alloy ATI 718Plus ..........................................................573
A. Casanova, M. Hardy, and C. Rae

Invention of a New 718-Type Ni-Co Superalloy Family for High Temperature Applications at 750°C .................................587
T. Fedorova, J. Rösler, B. Gehrmann, and J. Klöwer

Anisotropy of Room Temperature Ductility in Haynes 282 Forgings ..............................................................................601
C. Joseph, M. Hornqvist, and C. Persson

Environmental Effects on Microstructure and Properties

High Pressure Steam Oxidation of Ni-Base Superalloys in Advanced Ultra-Supercritical Steam Boilers and Turbines ...............613
G. Holcomb

Measurement of Hydrogen Embrittlement Resistance of Alloys 718 and Custom Age 625 Plus Using the Rising Step Load Technique .................................................................629
S. Kernion, J. Magee, T. Werley, P. Maxwell, and B. Somerday

Effect of Aging Treatment on Pitting Corrosion and Corrosion Fatigue Crack Propagation Behavior of Oil-Grade Alloy 718 ................................................................................643
J. Nutter, T. Chen, J. Hawk, and X. Liu

Comparative Performance of Three High-Strength Ni-Cr-Mo Alloys in Oilfield Simulated H2S Environment ..........................659
I. Roy, T. Collins, and R. Bhavsar

Effect of Environment on the High Temperature Oxidation Behavior of 718 and 718Plus .................................................667
K. Unocic and B. Pint

Posters

Age-Hardened Nickel-Base Alloys for Advanced Energy Applications ........................................................................681
J. de Barbadillo, B. Baker, and R. Goltilhue
Use of Slow Strain Rate Tensile Testing to Assess the Ability of Several Superalloys to Resist Environmentally-Assisted Intergranular Cracking ............................................................ 697
T. Gabb, J. Telesman, A. Banik, and E. McDevitt

Influence of Both Temperature and $\gamma'$ Distribution on the Development of Strain Incompatibilities at Grain Boundaries at Low Temperature in the UDIMET™ 720 Li Superalloy .......................................................... 713
B. Larrouy, P. Villechaise, J. Cormier, and O. Berteaux

The Influence of Solution Heat Treatment Temperature on the Hardness Response in Incoloy 945 ................................................................. 729
I. Martins, W. Monteiro, and A. Andrade

Formation of Nanocrystalline Structure Upon Severe Thermomechanical Processing and Its Effect on the Superplastic Properties of Nickel Base Alloys .......................................................................................... 739
V. Vaitlov

The Effect of Carbon Content on High Cycle Fatigue Behavior of Metal Injection Molded 718 Superalloys ............................................................. 751
N. Tsuno, T. Yoshinouchi, S. Ikeda, and H. Yoshizawa

Correlation of Secondary Dendrite Spacing with the Mechanical Behaviour of Cast 718 Alloy .................................................................................. 757
N. Soldevilla and O. Caballero

The Influence of $\Delta$ Phase on Mechanical Properties of ATI 718Plus Alloy .......................................................................................... 769

Surface Morphology Evolution of IN718 Alloy Etched by a CuSO$_4$-HCl-H$_2$SO$_4$ Etchant ............................................................................. 777

Residual Stress Control for Superalloys Disk in Cooling Treatments .......................................................... 787
Z. Bi, C. Tang, J. Qu, J. Du, and J. Zhang

Influence of Microstructure on Deformation Behaviour of Alloy 718 .................................................................................. 799
J. Johansson and C. Persson

Inconel Alloy 740: Potential for Use in A-USC Castings .................................................................................. 809
P. Jablonski and J. Hawk

Considerations for Homogenizing Alloys .................................................................................. 823
P. Jablonski and J. Hawk

Microstructure and Properties of Modified IN718 Alloy Added P and B .................................................................................. 841

Controlling Precipitation of Alloy 718 with Different Nb Content and Relevant Effect on Mechanical Behaviour .................................................................................. 849
O. Tassa, L. Alleva, A. Gotti, J. Kloewer, and A. Aghajani

Oxidation Behavior of Haynes 282 in Steam at 750°C .................................................................................. 863

The Effect of Strain and Temperature Profiles on Static Recrystallization during Solution Heat Treatment After Hot Deformation of Alloy 718 .................................................................................. 873
R. Watson, M. Preuss, J. Quinta de Fonseca, T. Wituki, and G. Terlind

C. Hefferan, S. Li, J. Lind, R. Pokharel, U. Lienert, A. Rollett, and R. Suter
PREFACE

The patent for Superalloy 718 was initially applied for in 1958 and awarded to Herb Eiselstein on July 24, 1962. Over the past 52 years, Superalloy 718 has established a firm position on production products ranging from deep wells in oil patch applications to critical rotating parts in advanced turbofan engines.

This collection of proceedings includes the manuscripts of presentations and posters given at the 8th International Symposium on Superalloy 718 and Derivatives. During the past half century, a menagerie of alloys has been tailored to address unique process or product needs in the industry. These versatile alloys require advanced melt and conversion practices to ensure reproducibility from lot to lot and subsequently from part to part. It is therefore fitting that advances in their use continues to lead the way to advanced processing technologies including additive manufacturing, metal injection molding, and cold sprayed coatings and associated new applications.

The 8th International Symposium on Superalloy 718 and Derivatives was designed to provide a very concentrated and intense venture into the fundamental and practical aspects of this alloy group. The conference followed the format used in prior symposia on the subject consisting of an evening opening talk followed by three days of detailed presentations. The conference was centrally located in Pittsburgh, Pennsylvania to facilitate access from Europe and the Far East as well as Central and South America.

This 8th symposium continued the successful expanded technical scope established at its last meeting in 2010. Through the joining of multiple metallurgical disciplines, the future of Superalloy 718 and derivatives were addressed through an understanding of the fundamental science and processing of the alloys. The symposium was made up of focused sessions which progressively provide an understanding of the microstructural development from alloy composition through final property response. Individual sections were provided and included raw materials, melting, casting, deformation processing, joining, thermal treatments, microstructural evolution, properties, environmental effects and modeling.

Over 100 abstracts were received for the conference, and a significant number of these advanced to be part of this proceedings. The focus of the conference was to provide an opportunity for leading technologists in the field to present their work for peer review as well as develop relationships within the technical community to exchange concepts and develop new ideas. In order to facilitate this exchange, the conference committee structured the conference to balance formal presentations with multiple poster sessions to maximize opportunities for researchers to interact.

The technical committee worked to maintain discipline in selecting the manuscripts for presentations at the symposium of the highest quality and encapsulating the innovative spirit of the original symposium organizer, Edward Loria (1916–2010). The intention of the committee was to provide a meaningful collection of the latest developments for Superalloy 718 and derivatives in a concise and accessible electronic media. On behalf of the committee, we hope you enjoyed the conference and find value in the proceedings.

A. Banik
CONFERENCE PROCEEDINGS EDITORIAL BOARD

Board Chair
Eric Ott
GE Aviation

Board Members
Joel Andersson
GKN Aerospace Engine Systems

Anthony Banik
ATI Specialty Materials

Ian Dempster
Wyman Gordon, PCC

Tim Gabb
NASA Glenn Research Center Jon Groh
GE Aviation

Karl Heck
Carpenter Technology Randy Helmink
Rolls-Royce

Xingbo Liu
West Virginia University

Agnieszka Wusatowska-Sarnek
Pratt & Whitney
CONFERENCE ORGANIZING COMMITTEE

General Chair
Anthony Banik
ATI Specialty Materials

Technical Program Coordinator
Xingbo Liu
West Virginia University

Technical Review Coordinator
Eric Ott
GE Aviation

Program Committee
Joel Andersson
GKN Aerospace Engine Systems

Ian Dempster
Wyman Gordon, PCC

Tim Gabb
NASA Glenn Research Center

Jon Groh
GE Aviation

Karl Heck
Carpenter Technology

Randy Helmink
Rolls-Royce

Agnieszka Wusatowska-Sarnek
Pratt & Whitney

Xishan Xie
Science and Technology University of Beijing
Loading Adobe® Reader® 9.0

This disk is set up for Adobe® Reader® version 9.0 or higher. If you must use an earlier version (e.g. because Adobe does not have a 9.0 or later version available for your operating system) then all of the disk's features may not be active.

For Windows 7, Vista, XP, and 2000, Adobe® Reader® can be installed from this disk. The Install program is located in: \reader9\windows\AdbeRdr910_en_US_Std.exe

Instructions for Adobe® Reader® 9.0

Document Management and Search Settings

It is important to check your Adobe® Reader® settings to provide the most ease of use when navigating this disk. Many windows opening simultaneously can slow down your computer. To set your preferences to the recommended settings follow these steps:

1. Select Edit on the menu bar
2. Then Preferences
3. Under Categories; select Documents
4. Add a check to the box for Open cross-document links in same window
Using the Search Feature

Initial Use

When you load the disk the system will attempt to start the file called welcome.pdf. The Search index is tied to this file and it must be started first. There are buttons on this start page to help you navigate.

The first time you run the search feature from the disk you will be prompted to allow the use of the Index file for searching. Check the box by “Don’t ask me again” if you don’t want to click the Load button each time you run the disk, then click Load.

Search Window

You may access the Search feature with the persistent bookmark in all PDFs of this collection that will open the Search window. Or on the menu bar, select Edit > Search.

Use the top text box for your primary keyword search query. In the example shown we’re searching for “materials”.

Make sure that the radio button is filled in for the option “In the index named mst_2010_index.pdx”. If this option does not appear try returning to the welcome screen by clicking the “Welcome” bookmark. This will automatically relaunch the index file loading process.

Below that check any appropriate boxes to choose more options that define your search.
**Using the Search Feature (continued)**

**Narrowing Your Search**

If your search yields too many results you can also refine your search. After your initial phrase search, the top of the resulting window will show “Search within the previous results.” You can change all of your criteria at this point. You don’t have to include your last search phrase as the search function will only use the last results found.

You can force the Search tool to use only the current document when searching for a word by clicking the option that says “Find a word in the current document”. However this can also be accomplished by using the *Find* feature. If you use *Find* for single document queries any search results will remain undisturbed in the search window. Once your query in the *Find* text box is typed, press enter. The reader will search the document for your phrase and highlight its first instance. If multiple entries exist, press the Find Next icon shown to see the next result.
**Navigation Buttons and Descriptions**

To help you navigate this disk the following are common buttons found in Adobe® Reader®, followed by a short description. You can turn on text labels for buttons by selecting View > Toolbars > Button Labels > All Labels.

NOTE: The *Find* and *Search* features behave differently. *Search* is much faster for searches across large collections like this disk. *Find* does not use the catalogued Index file, but may be faster for searching within a single article.

- **First Page**
- **Previous Page**
- **Next Page**
- **Last Page**

- **Search**
- **Print**
- **Fit Page**
- **Fit Width**

- **Find**
- **Zoom**
- **Zoom In**
- **Zoom Out**

There are bookmarks in each file to open the *Search* window. However you may want to add the *Search* button to your toolbar. The *Search* icon is not visible by default. To add the Binoculars icon to the icon bar select View > Toolbars > More Tools. In the resulting window check the box by *Search*.

You can customize your experience by enabling navigation and viewing buttons in this window like *First Page* and *Last Page* shown above. There are many other useful buttons here that you may want to enable.
**Bookmarks**

The bookmarks provided are intended to allow you to navigate across sections or articles and access common Reader features.

**Welcome** - Displays the opening screen, which loads the index
**Copyright** - Displays the copyright for this disc
**Abstracts** - Shows the Final Program for the event, which contains the abstracts for all articles and information about the event
**Table of Contents** - Lists all articles arranged by subsection
**Author Index** - Displays the list of authors and links to their papers
**Subject Index** - Displays a list of keywords and links to articles
**Help** - Shows this help file
**Print** - Shows the print dialog box for the current file
**Search** - Opens the Search window which will search all papers
**Exit** - Exits the reader.

If the bookmarks window is accidentally closed you can open the pane again with the bookmark button. Or from the menu bar you can access the bookmarks from View > Navigation Panels > Bookmarks.
8TH INTERNATIONAL SYMPOSIUM ON
SUPERALLOY and Derivatives 718
CONFERENCE PROCEEDINGS

Keynote Session
LESSONS LEARNED FROM THE DEVELOPMENT, APPLICATION AND ADVANCEMENT OF ALLOY 718

Francis R. Preli and David Furrer
Pratt & Whitney, 400 Main Street, East Hartford, CT 06108, USA

Keywords: Alloy 718, Superalloys, Development, Environment, Aerospace, Turbine Engines

Abstract

Materials play a significant role in the development and advancement of engineered components and systems. This is particularly evident in the aerospace industry where critical component and system attributes of weight, mechanical performance, temperature capability, manufacturability and overall cost drive the development and implementation of materials. Alloy 718 is a unique superalloy that was developed many decades ago, but has continued to fill critical requirements for current and emerging products. This material has a balance of attributes that have made it one of the world’s most utilized superalloys. Alloy 718 continues to evolve in engineering and design definition for specific applications through optimization of chemistry, microstructure, manufacturing processes and advances in application designs. The lessons learned from the development, application and continual improvement of Alloy 718 need to be utilized as we seek next generation materials to provide similar versatility and longevity.

Introduction

Materials selection and capabilities are critical for advancement of engineered systems. In the aerospace industry weight and cost are significant drivers in the selection of materials. For turbine engine applications, environmental resistance, including temperature capabilities and corrosion resistance are also paramount. Metallic materials for structural applications are continuously evolving to meet the changing requirements of new system designs and architectures.

A material that has continued to fit the needs for turbine engines throughout the evolution of designs and architecture is Alloy 718. This material continues to provide a unique combination of mechanical property capabilities, cost and manufacturability. How this material has positioned itself as a workhorse for many challenging applications is very interesting and provides insight relative to how future materials should be designed. There are many lessons learned from this material system that can be applied to other materials.

Meeting the Challenges of Numerous Industries and Applications

Materials provide specific combinations of capabilities to enable a wide-range of engineered consumer and industrial products. Engineered materials are present everywhere and are the cornerstone of successful component designs and complex systems. There are a number of
common and unique material challenges within disparate industry sectors, including general industrial, chemical processing, energy and power generation, and aerospace and propulsion.

A common challenge for all industrial sectors is economics. Materials that fulfill the mechanical requirements for component applications must also be cost effective. Customers of engineered products are continually seeking best value; therefore successful engineering designs must incorporate materials that enable lowest overall system installation and operating costs.

This is seen dramatically in the aerospace and energy industries where system costs are accompanied by significant operating costs and associated system fuel efficiency is of significant concern. Figure 1 provides the industry average costs of airline cash operating costs. The cost of fuel has grown from 14% a little over a decade ago to approximately 45% today, and is projected to grow even further in the future.

![Airline Cash Operating Costs](image)

**Figure 1.** The major elements of airline cash operating costs as a function of time shows a dramatic increase in the percentage attributed to fuel. (Fuel cost data from U. S. Energy Information Administration.)

For the aviation industry, propulsion systems that deliver improved fuel efficiency are highly desired. To achieve increases in fuel efficiency there are two main interdependent paths that must be taken, which are increased system efficiency through system architecture, and increased thermodynamic efficiency through increased system pressures and temperatures.

Emerging turbine engine concepts are being driven by the need for ultra-fuel-efficient capabilities. Traditional turbine engine designs relied on significant change in airflow velocity to produce thrust (e.g. turbojet). Advances in turbine engine design resulted in greater efficiency engines through the smaller increase of velocity of much larger volumes of air by increasing bypass ratios (e.g. turbofan). Figure 2 shows the improvement in fuel efficiency as a function of turbine engine design. Continued advancement in these architectures has been through increases in efficiency of sealing, higher pressure ratios, and increased core temperatures.

The next generation of turbine engine architecture has been recently developed and implemented by Pratt & Whitney and results in even greater increases in fuel efficiency. This revolutionary architecture is called the Geared Turbofan® engine. Its architecture incorporates larger fan diameter that create large bypass ratios which enables significant increases in fuel efficiency. Previous, conventional turbofan architectures reach a limit in fuel efficiency improvement due to
Figure 2. Schematic of relative fuel efficiency in terms of thrust specific fuel consumption (TSFC) as a function of aircraft engine architecture. Increases in bypass ratio (BPR) have provided a steady increase in fuel efficiency.

Increases in weight and reduction in efficiency of low pressure turbines that are required to run at low speed to match that of the larger fans. The geared turbofan enables the fan to operate at an optimum speed and also allows the low pressure turbine to run at much increased speeds to maximize efficiency. Figure 3 shows schematically the increase in aviation turbine engine efficiency as a function of fan diameter for conventional turbofan and geared turbofan configurations.

Figure 3. Relationship between fan diameter and engine architecture on overall system efficiency.
This new architecture required advances in material development for unique properties and capabilities. Efficient turbine engine designs require an increase in temperature to achieve better thermodynamic efficiency. Creative design systems that employ cooling schemes enable gas path temperatures to increase while maintaining structural materials within safe operating limits. The use of cooling air or even cooled cooling air has a negative impact on efficiency, however. Reducing system pressure by bleeding off air for component cooling reduces thermodynamic efficiency and is hence discouraged for maximum fuel efficiency. Increasing component temperatures provides direct increase in potential system efficiency. Figure 4 provides an overview of the classes of materials and their specific strength and temperature capabilities and potential location within a turbine engine.

![Ashby-type diagram of materials that are utilized within turbine engines.](image)

Figure 4. Ashby-type diagram of materials that are utilized within turbine engines.

Development of materials that will sustain the property balance at higher temperatures is paramount, along with advances implemented to the existing ones that will tailor them for a specific use. Alloy 718 is a natural candidate material and this new engine utilizes several versions of it as depicted in Figure 5.

![Typical material utilization within modern commercial aircraft engines along with examples of Alloy 718 applications within the P&W Geared Turbofan engine.](image)

Figure 5. Typical material utilization within modern commercial aircraft engines along with examples of Alloy 718 applications within the P&W Geared Turbofan™ engine.
Alloy 718 has uniquely filled the requirements for a large range of industries and applications. It has the ability to be processed to a range of mechanical property capabilities that are unique to specific applications. Alloy 718 fills a niche in engineering design space relative to tensile strength, fatigue strength, creep resistance, corrosion resistance and especially cost. The use of Alloy 718 is roughly approximately double that of the next most widely used nickel superalloy in this class of cast and wrought alloys.

The features that make Alloy 718 so versatile and adaptable include the ability for this material to meet the design requirements for so many industries and applications. The mechanical properties of this alloy can be tailored to unique sets of capabilities through control of microstructure, including grain size and precipitate type, morphology, location and quantity. There are a number of industry and company proprietary specifications for Alloy 718 to meet specific, application challenges.

Many industries and applications require subtle and deliberate changes to the balance of base properties of Alloy 718. Aerospace applications often seek ultra-clean material with optimum combinations of strength and temperature capabilities. Energy applications, such as in nuclear power industries, require microstructure and property stability, and overall component durability. [1] Similarly, petro-chemical industries require enhanced corrosion and environmental resistance. [2] There has been considerable research relative to manipulating Alloy 718 properties by controlling microstructure. [3, 4, 5]

In addition to the flexibility of Alloy 718 to deliver specific sets of properties, this material is also one of the most processable high nickel containing industrial alloys. This alloy can be readily forged by all methods to produce nearly any configuration. Alloy 718 can be forged at very high strain rates (hammer forging) or very low strain rates for superplastic forming. [6, 7, 8] Alloy 718 has and continues to be processed by casting processes of all types and sizes to obtain mechanical properties. [5 - 9] This material is readily welded to support fabrication and repair processes. [10] Heat treatment processes have been designed to optimize specific properties for this alloy. All conventional heat treating processes have been used successfully to manipulate the final microstructure and properties for this material. Alloy 718 is very machineable, so it can produce myriad final product forms. This alloy has been extremely adaptable to a range of these processes through optimizing chemistry, cleanliness and microstructure.

One of the major attributes that make Alloy 718 unique and ubiquitous in industrial applications is its economics. This alloy contains less nickel and other expensive alloying constituents than other nickel-base superalloys. The inherent costs of this material based on alloy content make the economics of this material more stable as compared to more heavily alloyed materials. There are alloy variants that aim to further reduce the inherent alloy costs, but introduce alloy stability challenges. The industry standard chemistry of Alloy 718 has shown exceptional capabilities and stability for many applications.

The ability for Alloy 718 to fulfill the requirements of so many industries and applications has also supported the overall favorable economics of this material. Increased volume usage of
materials has a tendency to support overall lower material costs. Larger volumes enable mills to scale-up manufacturing and to produce wide ranges of standard forms. Recycling and reverting of scrap for this high volume material also supports a lower cost material infrastructure and capability. System costs are critical to all industries, so the lowest cost material solutions are always sought making Alloy 718 an attractive material selection option for challenging applications.

Alloy 718 has been modified to generate unique variants for specific requirements and applications through chemistry optimization. Table 1 lists the chemistry of Alloy 718 and related variants along with Waspaloy, the next most common superalloy, but which deviates from γ'' strengthening to enable increased temperature capabilities, and IN100, one of the original γ' strengthened P/M superalloys developed for high temperature applications. Higher strength versions of Alloy 718, such as PWA1472, have a balance of alloying elements that enable changes in the phase fractions of γ'', γ', and δ precipitates. A further departure from the original Alloy 718 chemistry is the 718Plus alloy family, where iron is traded for additions of cobalt, further stabilizing γ' in these alloys, though γ'' and δ are still present, which is a large difference in comparison to Waspaloy, which is solely γ' strengthened. These alloy chemistry modifications are for special purpose and can depart from the original low cost characteristic of Alloy 718 by incorporation of various quantities of high cost alloying additions. Additionally, boutique alloys also suffer from limited volume usage and recycle capabilities, which also adversely impact affordability. These challenges for variant alloys make the focus on optimizing the capabilities and balance in properties for Alloy 718 solely from processing and microstructure control even more important.

Table 1. Chemistry of Alloy 718 related variants and early generation gamma-prime strengthened nickel-base superalloys.

<table>
<thead>
<tr>
<th>ALLOY</th>
<th>Cr</th>
<th>Ni</th>
<th>Co</th>
<th>Mo</th>
<th>Nb</th>
<th>Ti</th>
<th>Al</th>
<th>Fe</th>
<th>C</th>
<th>B</th>
<th>Other</th>
<th>Ref.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alloy 718</td>
<td>18</td>
<td>54.2</td>
<td>-</td>
<td>2.9</td>
<td>5.3</td>
<td>1</td>
<td>0.5</td>
<td>18.1</td>
<td>0.2</td>
<td>0.004</td>
<td>-</td>
<td>11</td>
</tr>
<tr>
<td>Alloy 718SPF</td>
<td>19</td>
<td>52.5</td>
<td>-</td>
<td>3.1</td>
<td>4.9</td>
<td>1</td>
<td>0.5</td>
<td>19</td>
<td>0.022</td>
<td>0.006N</td>
<td>N</td>
<td>8</td>
</tr>
<tr>
<td>DA718</td>
<td>17.8</td>
<td>53</td>
<td>-</td>
<td>2.9</td>
<td>5.4</td>
<td>1</td>
<td>0.7</td>
<td>18.3</td>
<td>0.035</td>
<td>0.004</td>
<td>0.006</td>
<td>12</td>
</tr>
<tr>
<td>PWA1472</td>
<td>12</td>
<td>57.8</td>
<td>1 max</td>
<td>3.05</td>
<td>6</td>
<td>2</td>
<td>0.6</td>
<td>18</td>
<td>0.04</td>
<td>0.005 max</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>Cast 718Plus</td>
<td>18</td>
<td>9.1</td>
<td>2.7</td>
<td>6.5</td>
<td>0.75</td>
<td>1.45</td>
<td>9</td>
<td>0.06</td>
<td>0.005</td>
<td>1W</td>
<td>W</td>
<td>14</td>
</tr>
<tr>
<td>718Plus</td>
<td>17.4</td>
<td>52.4</td>
<td>9.1</td>
<td>2.7</td>
<td>5.5</td>
<td>0.7</td>
<td>1.5</td>
<td>9.7</td>
<td>0.02</td>
<td>0.005</td>
<td>1W</td>
<td>11</td>
</tr>
<tr>
<td>Waspaloy</td>
<td>19.5</td>
<td>57.8</td>
<td>13.8</td>
<td>4.3</td>
<td>-</td>
<td>3</td>
<td>1.4</td>
<td>0.2</td>
<td>0.03</td>
<td>0.006</td>
<td>-</td>
<td>11</td>
</tr>
<tr>
<td>IN100</td>
<td>12.4</td>
<td>55.65</td>
<td>18.5</td>
<td>3.2</td>
<td>-</td>
<td>4.3</td>
<td>5</td>
<td>-</td>
<td>0.07</td>
<td>0.02</td>
<td>0.06 Zr, 0.8 V</td>
<td></td>
</tr>
</tbody>
</table>

Alloy 718 properties can be readily manipulated through control of microstructure. Grain size is one of the controlling mechanisms. Hall-Petch strengthening is effective in the optimization of Alloy 718 and its variants. Figure 6 shows the properties of DA718 as a function of grain size. Finer grain size will provide increase in material strength.